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�����
�	  ��	�	
��
��

���  ����
�  

���  ������	
��  ��	�	
�
���

���  ����
�  �����
��	  ��	�����	  �	������ : 
1. �	�	�
���	  ���
	�  ���	��  SH ��  ��

  Business Model and Mapping �  ��
�  Presentation, �����  

����
��  �
�
���  SH �  ��
	  Presentation.  

   
2. �������	  ������  �����
����  �
�
���
  SH �  ��
	  Presentation. ���
���	  �
��

�	 , ���  �
�����  

�  �������  �  ��
	  Presentation �  ���
����  �
�  �
�����  �  �������  �  ��
	  Business Model and 
Mapping. �
�	���	 , ���  �  ��
	  Presentation �	�
����  
	  �����
 
	��� . 

 

 
3. !���

��	  �	���������  SH. "	  ��������	  ����	���  
	��������	������� . 
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�	�������
�	  �  ����	���  �	���������   

 ����	��	�  

  
	��������	������� : 

1. #��	�	�	  File > Check Global Consistency .  

 

 
2. ���������  �����	
�	 , �  �������  �����	� �
	��� , ���  �	���������  
	  ���	� ��  ��������	��� , �  

���
$��
	��� , �����  ��  ��  ��	�
��  	��  ������
��  ���  �
������ ..  
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3. "
 ���	  Yes, �����  ���
	�  ���	��  SH ���
  ������

  ���  �
������ . �����	���  ��
�  Consistency 
Check Manager. 

 
4. %���  �  ��
	  Consistency Check Manager �����
	���  ��  �$���
�  Error , ����
  
	��������  

���	�
������
��  �	���������  �  �
�������  ����	���  

  
	��������	�������  �

��� . 

%���  �����
	���  ������  �  ��	����	 �	
���  Warning  �  �	���	
�
����  Best Practices, ����
  ��  
�� 
�  �����
������
��  �  

 
��  �
����  Close. 
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5. # ��
	  Business Model and Mapping ���
���	  �
��

�	 , ���  �

���  ���
	�  ���	��  SH ���	
����  
�  ���
���
	� , ���  �	�	��  ���
	�  ���	��  ������

  ���  �
������  (��
�
��  ��� ��  �  
�	�	�	����
��	�  ��
�	�  ���	� ).  

 

 
6. ��
 ��  ����
��	  ��  ���
	�  ���	��  SH, �����	���  ��
������	  ��
�  Business Model. �
�	���	 , �  

���	  Available for queries  ���

���	
  &�
 �� .  

 
7. "
 ���	  OK  �����  �
�����  ��
������	  ��
�  Business Model. 

8. !���

��	  �	��������� . #��	�	�	  No, ����
  �
�  �������  �  ����	��	  

  
	��������	������� . (#�  
������  ���  ����	�
��  '�� ). 
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�������	  �������  �  ��������  

1. #��	���	  Manage > Security . 

 
2. # �	���  ��
	  Security Manager ���	�	�	  Users. # ��
���  ��
	  ��������  �������
�	��  

Administrator . 

 
3. # ��
���  ��
	  ��
 ��  ����
��	  ��  �������
�	��  Administrator . �����	���  ��
������	  ��
�  

User. 
4. # �
��
��	  User  �  ���	  Password 

��$��	  Administrator  �  �
�	�  �����	����	  �
����  �  ���	  

Confirm Password. # ���	  Logging level ���

����	  �

�	
�	  2. 
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5. "
 ���	  OK,  �����  �
�����  ��
������	  ��
�  User.  

6. #��	���	  Action > Close,  �����  �
�����  ��
�  Security Manager.  

7. !���

��	  �	��������� . "	  ��������	  ����	���  
	��������	������� .  

8. #��	���	  File > Close, �����  �
�����  �	��������� . 

9. #��	���	  File > Exit , �����  �
�����  ��
�  Administration Tool.  

�	�	������  �	������  Oracle BI  

 ���  �	�	�
����
  �	������  �
�
���
  Presentation Catalog �����
��	  ��	�����	  �	������ : 

1.  "
 ���	  Start > All Programs > Administrative Tools > Services . 

2. # ��
�������  ��
	  Services ���	���	  Oracle BI Presentation Server , 
  �
�	�  Action > Stop �����  
���

�����  �	���� . (
� 	  ���

����	  Oracle BI Server �	���� . )��  �	�����  �����  ����  
���

���	
�  �  �����  ������	 . 

 
  

3. �������	  <InstallDrive>:\OracleBI\server\Config \NQSConfig.ini  �  �������  Notepad �  ��	���	  


��

�	  �	��������� , �����  ��
�
��  

  &
��  �	���������  sh.rpd. # �	����  Repository ��	���	  # 
�	�	�  "Star", �����  �
����	
�����
��  ��
�


��  �	��������� . �
�	�  

  ��	����	�  �����	  
��	���	  ��	����		 : Star = sh.rpd, DEFAULT; '�
  �����
  ��
���
	�  

  �
$  �	���������  SH. 

 
NQSConfig.ini – '��  &
��  �
���
���
��� , �������  ������
	�  Business Intelligence Server ���  
�
����	 . # �


��  �	����  ��  ��
�
��  �	��	�� , �
���  �	���������  �  �


���  
	��������  
������
�� .  
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4. # ��
�������  ��
	  Services ���	�	�	  �	����  Oracle BI Server , �
�		  ���	�	�	  Action > Start . (
� 	  
��
�����	  �	����  Oracle BI Presentation Server . 

 
  

5. # ��
��	�	  �������	  http://localhost/analytics , ��	���	  Administrator �  ���	  User ID �
���� , 


 ���	  Log In . 

 

  

�����
�	  ��������  �  ��������   

1. *���
��	  ��  �����	  Answers,  �����  �	�	���  

  ���

���  Answers �  ����
��	  ��  SH �  ���	   
Subject Areas.  

 
# �


��  ����	�	  ��
�

  ������  SH, 
�  �� 	�  ����  ��
�

  �	���  ������  �	��������	�  Oracle 
Business Intelligence. 
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2. # �	���  ��
	  ���

���  Answers ����
��	  

  �

���  «+», �����  �������	��  ���	� ���	  �
���  
�	���� . #��	�	�	   ��	�  !	��
� , �����  ���
����  '���  ���
�
�	��  �  ����	���  �
����
 . # ��
	  
���
�
  ��������  �����	�   ��	�  !	��
� . 
 

 
 

3. *���
��	  ��   ����
�	  !	��
� , �����  ���
����  �  ����	���  �
����
 . +�  �
���  ��������  
���	���	  "��	�����  �������� . +�  �
���  ,
����	���	  ����
 �  ���	�	�	  #����  �����$ . 
 

 
  

4. #�  �� 	�	  ���	
���  �������  ��������  �  ���	�  �
����	 , �	�	�
����
�  ��  ��$��� . �	�	�
���	  
��������  �  

�
��  �	�	�  �	���� . *���	���  �
$	��  �
����
  �����  ������	��  �
� :  
 

 
 
(	�	��  �	�	�
���	  %����&	���	  �����$�  ���
�
� . 
 

 
 
  

5. "
 ���	  �

���  &�����
  Filter  

  ������	  "�����'  ���  ���
��	
��  &�����
 . 
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6. # ��
�������  ��
	  Create/Edit Filter, 

 ���	  All Choices ���  ��������
  ��	�  �

�	
��  ������
 . 

 
#�  �� 	�	  ���

����
��  �����	����  �

�	
�� , ���������  ����	���  �  ���	  Match. �
�		  ��  
�����
	�	  Limited Choices. 
  

7. # ���	  Operator ���	�	�	  �

�	
�	  "is greater than or equal to" �  

 ���	  «2000-01» ���
�
 . �
����  
«2000-01» ���
���
��  �  ���	  Value ���
�
 . "
 ���	  OK .  

 
,�����  ���
��	
 .  
  

8. "
 ���	  

  �
��
���  Results, �����  �������	��  �	�����
��  #
$	��  �
����
 . 
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#���'�����
�	  %�
�
��  ���������
��  

1. "
 ���	  

  Edit view   ���  ��������
  �
�����  

  ���

��	  – �
�	�	  ���	�
  Compound Layout.  

   

2. "
 ���	  Total By  

�  ��������  "�����' . ����	  �
 ����  ��
��
�
  �����
	�  ��������  ����� . 
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3. "
 ���	  Grand Total 

  �	��
	�  �

	��  ���  �����	
��  ����
  �
  �	��  ����


��  �	���� . 

 
  

4.  # ���	  Display  ���	�	�	  Results Only , �����  �������	��  �	�����
�  �	�  �

	��  �
�����	
���  
��	���  �
�����  Header Toolbars. 

 
  

5. "
 ���	   All Pages  �  ��
�	  �
����� . "
  ����	�
	�  �����	  #�  ������	  � ������	  �

�	
�	  �
  
����


��  �	����  Grand Total . 
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�����
�	  ���������  

���  ����

��  ��
&��
  ����	�
��	  ��	�����	  ��	�
��� : 
1. "
 ���	  Chart �  �	
�  View. ��  �����

��  ����������  ��	����
�  ��
��
��
   

(Vertical Bar graph).  

 
  

2. #��	�	�	  Line ��  �����
  �  ���	  Graph �  2D �  ���	  Type. 
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3. ���  �

����   ����
���	  �
�����  

������  "��	�����  �������� , �����  ���������  ��
&��  ��  
��	�  �
�	������  ��������� . "
 ���	  �
����  Redraw. 

 
 

4. "
 ���	  General Chart Properties . # ��
�������  ��
	  General, ����
���	  �
�����  

������  
Custom Title  �  ��	���	  #����  �����$  ��  �	����  2000-01 – 2001-04 �  

 ���	  OK . 
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5. (	�	��  ��
&��  ��		�  �
������� . 

 
6. #��	���	  Compound Layout ��  �	
�  View. 

 
  

7. "
 ���	  Add View �  ���	���	  Chart , �����  ���
����  ��
&��  �  ����  Compound Layout. 
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8. "
  ����	  Compound Layout �
  �
����	�  ��������  ��
&�� . 
 
 

 
 
 

9. "
 ���	  Delete View  �  �
��	�	  Title , �����  ��
����  	��  ��  Compound Layout. 
 
 

 
 
 

10. "
 ���	  Save Request  �  ��
���  ����  ���

��� . # ��
�������  ��
	  Save Request ���	���	  
Shared Folders, �
�	�  

 ���	  Create Folder. # ���	  Caption ���$��	  Learn �  

 ���	  OK . 
 
 

 
 
 
  

11. # ��
�������  ��
	  Save Request ����
��	  ��  �
��	  Learn. #�	���	  �  ���	  Name ���  #����  �����$  
�  

 ���	  OK . 
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��������  	(	  ���
  ��&	�  

12. 

"
 ���	  

  Create a new request , �
�	�  SH. 

 

13. +�  �
���  "�
�'�  �)���  ���	���	  �����)  �����$� ,  
��  �
���  ��������  ���	���	  "��	�����  �������� ,  
��  �
���  %����&	���	  �����$�  ���	���	  #����  �����$ . 

 

14. 
�	�	����	  

  �
��
���  Results. 
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15. 
# ���	  View ���	���	  Chart. 
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16. 

# ���	  Graph ���	�	�	  ���  ��
��
���  Pie. ���  �

����   ����
���	  �
�����  

������  �����)  

�����$� . ���  �

����   ����
���	  �
�����  

������  #����  �����$ . "
 ���	  �
����  Redraw. 

 

17. "
 ���	  General Chart Properties . # ��
�������  ��
	  General, ����
���	  �
�����  

������  
Custom Title  �  ��	���	  #����  �����$  ��  �����  ��
�'��  �)���  �
�  �
�������  ��
��
��� . # ���	  
Show Data Labels  ���	�	�	  Always. "
 ���	  OK . 
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������� : 

 
(	�	��  

  ��
&��	  �����
 
����  �

�	
��  ���	� . 

18. #��	�	�	  Compound Layout ��  �	
�  View. 

 
  

19. "
 ���	  Add View �  ���	�	�	  Chart , �����  ���
����  ��
&��  �  ����  Compound Layout. 
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20. 
-�	� ��
�  �
����  ��$� , �	�	�
���	  Chart ���
�� . 

 

21. "
 ���	  Save Request  �  ��
���  ����  ���

��� . # ��
�������  ��
	  Save Request ���	���	  
Shared Folders, �
�	�  �
���  Learn. # ���	  Name ��	���	  ���  "�
�'�  �����$  �  

 ���	  OK . 
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�����
�	  #
�	������
�*  ��
	'�  DASHBOARD  

1. �	�	����	  ��  �����	   Settings> Administration ��	���  ��

 . 

 
2. �����	���  
���	  ��
� . "
 ���	  

  ������  Manage Interactive Dashboards , �����  ����
��  
����  

�
�	�
����
��  �

	��  Dashboard. 

 
3. 

# 
����  ��
	  

 ���	  �
����  .  
4. # ���	  Dashboard Name ��	���	  ���  �
�	�
����
��  �

	��  #������  �����$ . 

 
5. "��
�  �
�	�
����

�  �

	��  #������  �����$  ����


 . "
 ���	  Finish . �
�	�  Close Window  �  

��
���  ���� , �����  �
�����  ��
�  Oracle BI Presentation Services Administration. 
6. �	�	����	  

  ���

���  Dashboards, 

 
�  

  ������  ��	���  ��

  Dashboards. 

 
7. �
�		  �	�	����	  ��  ����	  #������  �����$  ��	���  ��

 , �����  ���
���  

  ���

���  ������  ���  

����


��  �
�	�
����
��  �

	�� . 
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8. .����  

�
��  �
���
���  �
�	�
����
��  �

	��  #������  �����$  �	�	����	  ��  �����	  here. 

 
9. �����	���  ��
�  Dashboard Editor  ���
�
 , �
������	  �
���  Shared Folders, �
�	�  �
������	  Learn. 

 
 

10. -�	� ��
�  ��$� , �	�	�
���	  #����  �����$  

  ������	  ���$��  ���
�
 . 
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11. ���  ����  �����  ����
��  ������  �  ���	�
  #����  �����$  

  ���	�  "�
�'�  �����$ , ��	� ��
�  

��$� , �	�	�
���	  Guided Nav. Link  

  ������	  ���	  ���
�
 . 

 
12. !��
�
  �  ���$�	  Guided Nav.Link  

 ���	  Properties.  

 
13. # 
����  ��
	  Guided Nav.Link Properties �  ���	  Request or Dashboard 

 ���	  Browse. 
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14. # ��
	  Choose Request/Dashboard �
������	  �
���  Shared Folders, �
�	�  �
������	  Learn. 

*���
��	  ��  "�
�'�  �����$ . �
�	�  OK . 
 

 
15. # ��
	  Guided Nav.Link Properties  �  ���	  Caption ��	���	  #����  �����$  ��  �����  ��
�'��  

�)���  �  

 ���	  OK . 
 
 

 
 
 

16. "
 ���	  �
����  Save �  �	��
	�  ���� . 
 
 
 
 
 
 
 



 

 

 26

 
17. "
  ���

��	  #
$	�  �
�	�
����
��  �

	��  #������  �����$  ��������  �	����  ���	�  +����  

����
 . 
 
 

. 
18. ���������	  ���

��� , �
���  ���	�  �����
  

  ������  ���	�  "�
�'�  �����$ . 
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19. "
 ���	  

  ������  "�
�'�  �����$ . �����	���  ������  ���	�  "�
�'�  �����$ . 

 
20.  .����  �����  ��  Oracle BI EE 

 ���	  

  ������   Log Out  �  �	��
	�  ��
���  ���� . 
 
 


